
Linux Primer

Initial Steps

You have been given a login name and temporary password.  Provide these to the system at the 
login screen.  The system should then inform you that you must change your password right 
away, and will ask for the following information in order:

1. Your temporary password (the one you were given)

2. Your new password (the one replacing your temporary password, choose one that is less 
than 14 characters long)

3. Your new password again (as a check to be sure you typed it correctly the first time)

From then on your password on that system will be the new password you provided above, 
unless you change it again.  Your password for that system on the reservation system will update 
later that evening.

At this point you should be logged in and will soon see your desktop.  There are several popups 
welcoming you to the new system, verifying your language of choice, et cetera – just wiz 
through them.

Terminals

There are operations that require using the Linux terminal, most notably resetting the 
spectrometer.  To start a terminal right-click on the desktop and choose “Open Terminal” from 
the pop-up.

Reservations
Reservation rules vary from system-to-system, but may be found here: 
http://nmr.tamu.edu/rules.php.  The reservations are handled by nmrsun1 
(nmrsun1.chem.tamu.edu, 165.91.176.180) using a reserve program.  Use ssh to login to 
nmrsun1 with your login name and current password (which, again will start off as the temporary
password you have been given).  The system will rattle off a motd (message of the day) that 
always includes a reminder of proper usage, and the penalties for failing to do so.  The system 
will then prompt you to “Input display server name:” - just hit enter.  You should now see a 
prompt appearing as “ID 1>”, where ID is your login name.  At this prompt type “su reserve” and
the system will prompt you for your terminal type, if you're unsure choose “1: DEC vt100 
(default)” by keying in “1” followed by a return.  You should now see a listing of all the systems.

Press the number key for the system you'd like to reserve.  A new motd for that system may flash
up, please read that message as this is where the NMR staff will inform you of any special 
conditions affecting the system.  After you dismiss the system's motd with a keystroke, you will 
be prompted for your “Instrument User Name”.  If you leave the “Instrument User Name” field 
empty you may browse the system's current reservations, but may not make one yourself – you 
may do this even if you do not have an account on the chosen system.  However, to actually 
make a reservation you must supply the login name you have been provided as the “Instrument 



User Name” and hit enter.  You will then be prompted to provide the password for that 
instrument – yes, you could set up each instrument with its own password if you like.

Once you have logged into the system's reservation, you will be presented with a user 
information form.  The only required fields are phone number (in format #-####, including the 
dash) and lab/room number, but we suggest you fill out the rest of the information as well.  When
you are done, press “D” and you will be taken to the actual time reservation screen.  Permitted 
operations are located at the bottom of the screen, and the system automatically enforces the 
reservation rules.  When you are done making/viewing your reservation, press “Q” to quit and 
return to the full list of systems.  You may then choose another system, or exit the reservation 
program by hitting “Q”.  Once you have left the reservation program, logout of nmrsun by typing
“logout” at the command prompt – do not leave the system logged in while not in immediate use.

Reservation Terminals

In many of the NMR labs there is a second computer that is only for making/viewing 
reservations on that system.  This computer should already be logged into the appropriate Linux 
account, but the reservation system may not be running on it.  To get the reservation system 
running double-click on the “Start reserve.sh” icon and ask it to “Run in Terminal”.  Then wait, it
takes a minute.  Soon though, you will be asked the same questions you would be presented if 
you had logged into nmrsun1.  Tell the program that it's a VT100 terminal, choose the system, et 
cetera.

Rules and Proper Etiquette
There are some solid rules, and good practices.

• Never, for any reason, allow anyone else to use your login information.  Violating this 
rule can have severe repercussions at the university level for all involved.

• Never, for any reason, are you to bring a person with a pacemaker close to a magnet.

• Avoid bringing ferromagnetic materials anywhere near a magnet.  This includes most 
tools and office supplies.

• Be wary of bringing electronics close to a magnet, we are not responsible for their loss.

• Do not make a reservation you, yourself, do not plan to keep, and delete a reservation if 
circumstances prevent you from keeping it as planned.

• You may use an instrument without a reservation, but if someone has made a reservation 
during a time slot: that person has priority and you must surrender the instrument to that 
person.

• Do not use an instrument for any purpose other than that for which it has been designed 
and setup.

• It is not, and never has been, anyone else's responsibility to save your data, deal with your
sample, et cetera.  You need to make arrangements beforehand if you cannot be present at
the conclusion of your experiment, or you run the risk of losing it all.



• Data should be saved in your data directory.  We will not prevent you from saving data in 
other locations to which you have write privileges, but we will not backup data from any 
other location other than your data directory.

• You are subject to quota limits.  If you are over your quota the system will not run 
correctly, and you must address the quota limits before continuing.

• When your immediate use for an instrument is done, log out.  Do not switch user.  Do not
let the window sit there open.  Log out.

System Identification
The TAMU chemistry department systems are detailed below.  The name of the computer 
associated with the system and its IP are included as well.  Please note that each system is 
described for the configuration you are most likely to find, but other options may be utilized – 
check first.

Instrument Systems

1. VnmrS 300MHz System in Room 2211E
(nmrs300.chem.tamu.edu, 165.91.176.184)
This system is setup solely for the organic labs.  It is running VnmrJ 4.2A software in a 
Walkup mode – where operators do not log into the Linux account, but into the software.

2. Mercury 300MHz H/C System in Room 2413
(mercury300.chem.tamu.edu, 165.91.176.183)
The installed probe is tuned solely to 1H and 13C, so the system should not be used for 
any other nuclei.  Training on this instrument is part of your initial introduction to NMR.

3. Inova 300MHz H/F/P/C System in Room 313
(inova300.chem.tamu.edu, 165.91.176.182)
The current probe does not have a gradient coil, which limits your experiment choices.  
However, the system is certainly capable of running routine 1D H/F/P/C spectra.  
Training on this instrument is part of your initial introduction to NMR.

4. Inova 400MHz Broadband System in Room 1324
(inova400.chem.tamu.edu, 165.91.176.68)
This instrument has been designated for running nuclei other than H/F/P/C, and is 
equipped with a H/F{X} probe.  It is capable of running H/F/P/C as well, but should 
someone require a nucleus outside these four – that person will have priority on this 
instrument.

5. Inova 500MHz H/F/P/C System in Room 1221
(inova500.chem.tamu.edu, 165.91.176.67)
This system has a quad probe allowing it to do a wide-range of H/F/P/C experiments. 
Any choice of one high-band (H/F) and one low-band (P/C) nuclei may be done on this 
system.



6. VnmrS 500MHz H/F/P/C System in Reed-McDonald Room 415
(nmrs500.chem.tamu.edu, 165.91.223.23)
This system has four channels, and a matching probe.  This means that any combination 
of H/F/P/C experiment may be done on this system.

7. Avance III 400MHz Broadband System in ILSB Room 1163
(ilsb400.chem.tamu.edu, 128.194.148.6)
This system is capable of running proton with (almost) any choice of second nucleus.  
The system is equipped with a 16 position sample changer and automatic tuning.

8. Avance 500MHz Cryoprobe System in Room 1238
(avance500.chem.tamu.edu, 165.91.176.142)
This system is equipped with a H/C/N cryoprobe, and is meant for long acquisitions of 
low concentration samples.  It is equipped with a 24 position sample changer and 
automatic tuning.

9. VnmrS 500MHz Broadband System in Room 1327
(nmrs500.chem.tamu.edu, 165.91.176.178)
This system is equipped with a H/F{X} probe, and is similar in role to the Inova 400MHz
above.  This system has been set aside for very long acquisitions.

10. Avance 400MHz Solid-State System in Room 1321
(avance400.chem.tamu.edu, 165.91.176.66)
This system is setup to run solid-state experiments only.  It is not on the reservation 
system, contact Vladimir Bakhmoutov (1323 Chemistry, 979-845-8993, 
bakhmoutov@mail.chem.tamu.edu) to schedule time.

Workstation Systems

The NMR facility has also set up two workstations in 1318.  These workstations run TopSpin, 
and have all of your data independently backed up on them.  These systems are:

1. Proton
(proton.chem.tamu.edu, 165.91.176.232)

2. Deuterium
(deuterium.chem.tamu.edu, 165.91.176.225)

Data backups are currently done every half hour on both systems, and the systems are offset by a 
quarter hour.  There are also scripts running that copy over your data on demand, but if you wait 
no more than half an hour one of these workstations will have your data available.

On these systems your data may be found in a directory with your adviser's name, your login 
name, and the instrument name.  For example, if kjhwang from the Payne lab had acquired her 
data on the VnmrS 500MHz, her data would be in /data/payne/kjhwang/nmrs500.  There is a link
to /data on your desktop, and you can browse to the appropriate location from there.

You may retrieve your data from these workstations by using sftp or by using a flash drive.



TopSpin

TopSpin is software from Bruker that may be downloaded for free for academic purposes.  If 
may be found here: https://www.bruker.com/service/support-upgrades/software-
downloads/nmr/free-topspin-processing/free-topspin-download.html.  We suggest assigning your
data directory to your login named directory (/data/payne/kjhwang in the above example), and 
then tunneling into the sub-directories to import/convert your data from there.

Reservation System

Currently reservations are made on nmrsun1 (nmrsun1.chem.tamu.edu, 165.91.176.180).  The 
system does have an older version of VnmrJ (version 2.2C), but is primarily used for managing 
reservations.

Quotas
Quota limits have been enabled on all NMR instrument computers and the workstations (Proton 
and Deuterium).  This has been done to keep user accounts from becoming too large due to 
unnecessary files, such as internet cache or pictures.  With this in mind quotas have been broken 
up into 2 types: home directory and data storage. 

On the instrument computers your home directory quota limit is 100MB.  This includes any files 
within your home directory, except those files you store in your ~/vnmrsys/data directory.  On 
each instrument computer your data storage quota is 1GB, which applies to only those files 
stored in your ~/vnmrsys/data directory.  Since all computers are stand alone systems, these 
quotas are per machine – not your on accounts as a whole.

On the workstations your home directory quota is, again, 100MB.  Your data is not stored in your
home directory, but pictures you save will be – so keep an eye on this.

To help manage your data storage we recommend you go into Firefox (the internet browser) on 
each system and put a limit to the cache size that it can store to 5-10MB.

Quota Pop-Up notices

From time-to-time, you will get Pop-Up windows when you login to the facility's computers.  We
use these to give you important information about the systems, including when you are at 70% 
usage of your quota limits.  These are your warnings to start moving files and watching your disk
usage.

Once you have reached your quota you will not be able to login to the system.  When you are 
about 90% of your limit VnmrJ will stop working!



Setting the Internet Browser cache limit

On the NMR instruments this can be done by the following steps:

1. Start Firefox from the icon on the top Menu Bar.

2. On the right side of the Browser is a menu button click this and go to Preferences.

3. Choose Advanced from the left sidebar.

4. Click the Network tab.

5. Check the box for “Override automatic cache Management”.

6. Set the MB limit the box below.

7. On this page is also a Clear Now button you can use this to reset the program to zero to 
start fresh.

Checking your disk usage

From a terminal window this can be done by typing the command “du –h ~”.  This will produce 
a detailed list of your disk usage by directory.  Look for the directories that are using the most 
disk space and move files as you need too.

From the graphical file browser you can right click on a directory and use the Properties feature 
to get disk usage as well.  This method will be more time consuming.

If you need help with moving files please see the NMR staff.  It is also recommended that for 
help with Linux commands you take Dr. Lisa Perez’s Linux class offered at least once a year.

Illustration 1: Firefox Top Bar



Overview of VnmrJ 4.2A

Layout

Help Overlay

This is a cartoon of the VnmrJ software window, it greets users whenever the user account has 
been updated.  Its goal is to provide you the names associated with the various elements in the 
software window, and give a short description of what you may find in those elements.  In the 
lower left of this help overlay is a check box, which, if toggled, will prevent the splash screen 
from greeting the user until the account is updated.  The splash screen may be dismissed by 
clicking the red X in the upper right of the help overlay.

Menu

Not shown on the help overlay is the software menu.  This menu lies at the very top of the 
software interface.  Almost every function available within the Menu can be found in some other 
part of the software interface.  This redundancy is completely intentional, and it does not matter 
where you make your selection.

File

In the File drop-down the user may create a new workspace (cexp(#)), join an existing 
workspace (jexp#), open a data set, save a workspace's data, deal with printing, print the screen, 
change operator, and exit VnmrJ.  The safest way to exit VnmrJ is to use the “Exit VnmrJ” 
option in the File drop-down.

Illustration 2: VnmrJ 4.2A Help Overlay

Illustration 3: VnmrJ 4.2A Menu



Edit

In the Edit drop-down the user may move parameters from one workspace to another, create 
special pulses, create macros and buttons, change the content and cosmetics of elements in the 
interface, set preferences, and designate hardware.

View

In the View drop-down the user may choose which elements of the software interface to display. 
In other words, the Edit drop-down governs how elements are displayed, and the View drop-
down governs whether an element is displayed at all.  Some of the various panels within VnmrJ 
can also be brought to the foreground using the View drop-down.

Experiments

The Experiments drop-down contains all of the standard protocols available to the user.  
Choosing a protocol from this drop-down is in every way the same as choosing that protocol 
from the Experiment Selector.

Acquisition

In the Acquisition drop-down the user may setup an array, start the console running a process 
setup in the workspace, or stop a process not running in a Study Queue.

Automation

The Automation drop-down has choices for dealing with experiments being run in a Study 
Queue.  

Process

The Process drop-down contains utilities for automatic processing and analysis of data.

Tools

The Tools drop-down is a hodgepodge where a user can create a protocol button, check the 
content of all workspaces (explibPopup), start probe tuning, start shimming routines, use the 
Locator, create a picture, change referencing, and even change the sample.

Help

Here the user can find access to the VnmrJ manuals in html format, view the help overlay, be 
linked over to Spinsights, and checkup on the installed software.

Vertical Panels

Protocols (Experiment Selector)

By far, this is the most important Vertical Panel, as this is where the user does the initial 
experiment setup by clicking on a protocol.  The Experiment Selector is initially displayed as a 
tree, but may also be displayed as a field of larger buttons and tabs from the View menu.  
Selection of a protocol is always required before starting an experiment.  Choosing a protocol 
here is the same as choosing a protocol from the Menu's Experiments drop-down.



Quick Submit

The Quick Submit Vertical Panel pares down the spectroscopy experience to the bare minimum.  
With a few entries and choices, a data set is acquired and saved.

Frame

The Frame Vertical Panel is for creating insets, and adding text and graphics to a spectrum.

Viewport

The Viewport Vertical Panel allows the user to display multiple data sets at the same time.  Such 
a display may be printed by using the Print Screen option in the Menu's File drop-box.

Process Plot

This Vertical Panel has a selection of the most common processing, display, and printing options.

Arrayed Spectra

It is possible to acquire multiple spectra in a single data set, this is called an arrayed data set.  
The Arrayed Spectra Vertical Panel contains many of the options used to display these multiple 
spectra.  To be clear: an array is a single data set with multiple spectra and is dealt with on this 
Vertical Panel, but to deal with multiple data sets use Viewport.

Others

There are other Vertical Panels for other applications and hardware.  For example there is a 
Vertical Panel for the cryobay if a system is equipped with a cold probe.

Command Line

Every single button and operation in VnmrJ can also be executed on the Command Line.  The 
Command Line is a field for text entries to run the system.  Just above it is a scrolling text output
(closed initially, drag the Command Line down to see), where the system reports what it is 
doing/has done.  Most people use a combination of Command Line and button entries to run the 
system.

Illustration 4: Protocol Vertical Panel



Graphics Canvas

This is where the user views and interacts with the acquired data and other graphical output.

Study Queue

The Study Queue allows the user to construct a linked list of experiments for a given sample.  
The Study Queue then runs each experiment in turn, and saves the data in a single folder but as 
separate data sets.

Parameter Panel

The Parameter Panel contains text entry for sample setup and identification, and all the elements 
of the pulse sequence required to acquire and process the data.  The vernacular is that the 
Parameter Panel has tabs (like Start, Acquire, and Process), and those tabs have pages (like 
Sample Info, Lock, Shim, and Spin/Temp).  A tab also has an array of buttons at the top of the 
Parameter Panel, to the right of the tab selections, which execute useful commands within the 
selected tab (like Show Time, Go, Stop, Arrays, Sequence Diagram, and Sequence Help).

Toolbars

System Toolbar

Located just below the Menu this toolbar contains several of the option the the File drop-box.  
Turning this toolbar off also hides the User Toolbar.

User Toolbar

In the same location as the System Toolbar, this toolbar is for user-created buttons and similar 
options.

Graphics Toolbar

This toolbar's default location is on the far right of the interface; however, the user may move 
this toolbar.  The elements of this toolbar are context-specific, but involve tools like zoom, 
integration, phasing, and drawing.

Hardware Toolbar

This toolbar is located at the very bottom of the interface.  It is made up of four distinct zones: 
trashcan, hardware status, acquisition status, and messages.  The trashcan is used to remove 
elements of a Study Queue before the queue is submitted.  The hardware status reports the 
sample temperature, spinning rate, lock level, sample position, and probe installed.  Clicking on 
a hardware status button will open an interface related to that report, often a plot.  Choosing the 
probe opens up a popup where you may view the values used by the protocols to setup 
experiments.  The acquisition status indicates what the current state of the console is; for 
example, sitting Idle.  The messages come in two types: acquisition and Vnmr – roughly put: 
those related to taking in data and those related to functions in the software.



Acquisition

First Steps

Start VnmrJ 4.2A by double-clicking on its desktop icon.  The program may load with the help 
overlay on top that shows the names of the fields within the software.  There is a little check box 
in the lower left that will disable this feature for future starts, we suggest you toggle that check 
box.  Next there is a “X” box in the upper right that will dismiss the splash screen.  You are now 
ready to use the system.

Don't Panic.  If you're a seasoned VnmrJ user, (almost) all of your old commands, macros, et 
cetera will work fine in this version of VnmrJ.  You do not have to change your ways, but things 
are sometimes in different places, work a little differently, or have better options than they did in 
days of old.  The rest of this guide is going to focus on using the GUI, but if you prefer the 
command line feel free to use it instead.

With the Start tab selected, click the Eject button.  Take the placeholder sample from the 
magnet's upper barrel, remove the tube from the spinner, and carefully install your tube into the 
spinner – make sure to use the depth gauge to align it properly.  Then place your sample in the 
upper barrel, go back to the software and click the Insert button.  The gas flow supporting the 
sample should cease, and soon you will hear a small thunk, which indicates the sample has 
reached the bottom of the upper barrel.

Lock

To compensate for drift in the static field and to provide a reference frequency, the spectrometer 
has a dedicated deuterium channel.  In choosing deuterium as the lock nucleus several things are 
accomplished:

1. Deuterated solvents have the same solubility properties as the natural abundance solvents,
but lack substantial proton signal.

2. Deuterium is a spin-1 nucleus with a reasonably short T1 permitting the use of rapid 
pulse-acquire or swept CW acquisition.

3. The deuterium signal can be used as an internal reference as the resonance position of the 
2H signal can be compared to other nuclei by using a ratio of the gyromagnetic ratios. 

The low natural abundance of deuterium is also key.  In general, the deuterium signal from the 
lock solvent is the only observable signal in the spectrum.  This uniqueness facilitates the 
referencing, locking, and shimming.  Mixtures of solvents or solvents with deuterons in different 
chemical environments (like THF or ethanol) can have issues.

The referencing is sometimes a point of concern.  The system finds the deuterium position in the 
lock solvent, and then calculates what the shifts in the spectrum should be given that position and
solvent.  The system has no idea if you have your own internal shift standard in the sample or 
not.  In general, the calculated shifts are very close to spot-on, but if you need shifts relative to an
internal standard you will have to re-reference your spectra.



Locking by Hand

You should only have to do the locking by hand once in a long while, but every now-and-then 
the lock phase changes or your sample conditions require it.  To lock a system by hand go 
through the following steps:

1. In the Start tab's Sample Info page: choose the solvent.

2. Choose the Start tab's Lock page and start the Lock Scan by tapping its button.

3. Make sure the check box next to Lock is empty.

4. Manipulate z0, lock power, lock gain, and lock phase until an appropriate step-profile is 
produced.

5. Toggle the check box next to Lock.

6. Turn off the Lock Scan by tapping its button.

The lock phase does vary some from sample-to-sample, but not very much.  Truth is, close 
counts.  In fact, there is an entry for the lock phase in the probe file, so you might want to start 
there.  However, sometimes, usually following a power outage, the lock phase shifts by some 
random increment of 90-degrees.  If in later use the lock level is very low (lock profile 
incorrect), this sort of shift may be the root cause – so it's good to know how to manually lock.

The magnitude of the lock is largely unimportant, so long as the system reports that it is locked.  
The lock power and gain do regulate the magnitude of the lock, but they have to be used 
properly.  If you overdue one or the other, you can saturate the signal and compromise the 
system's ability to reference.  A quick check involves dropping the lock power by 6, and the lock 
level should then be about half what it was initially.  Then, after returning the lock power, do the 
same for the lock gain.  If the lock level is not about half, you're overdoing the lock power and/or
lock gain.

If you cannot manipulate the lock to achieve the appropriate step-profile, please ask for 
assistance.

Auto-Lock

More often than not, you need only select the proper solvent and click the “Auto lock” button at 
the top of the Start tab of the Parameter Panels.  The system will then take a 2H acquisition, set 
the lock offset, and get the lock power and lock gain from the probe file.  The lock power and 
lock gain have been calculated for a sample of the chosen solvent at >99%, if your sample differs
you will still need to adjust the lock power and lock gain.

Shimming

Shimming is the term given to the application of small currents to precisely wound coils to 
correct for inhomogeneity in the static field.  Inhonogeneity in the static field leads to signals that
are broad, distorted, and misleading.

First Steps

There are always some shim sets saved off to get you started.  You do (and should) not have to 
trust the shimming work of the previous user.  Read in a set of shims using one of the following 



methods: rsh command, the shim File field, Locator, or a previous data set.  The rsh and shim 
File field require you to know the name of the shim file you wish to load.  Just entering rsh on 
the command line will produce a prompt for that file name.  In the Start tab's Shims page there is 
a shim File field, you can enter the shim file name there and tap the “Read shims” button.  The 
Locator is a part of VnmrJ used to keep track of all sorts of things, and allow you to find them as 
you need them.  The Locator itself is in the Menu's Tools drop-down, listed as “Locator ...”  
Selecting this option opens a popup, left-click on the magnifying glass in the upper left, then 
select “Sort Shimsets – by probes and shims”, then at the top of the Locator right-click the first 
All and choose the probe that is currently installed (check the Hardware Toolbar).  Then you may
choose an appropriate shim set for that probe on this system.  You may also read in the set of 
shims used to acquire a data set by loading that data set into an experiment and typing “load='y' 
su” on the command line.

Gradient Shimming

More often than not, a user need only run the gradient shimming to adjust the z-shims (the 
spinning shims) and spin the sample to obtain a good lineshape.  The easiest way to run the 
gradient shimming is to first lock the sample then tap the “Gradient shim” button at the top of the
Start tab of the Parameter Panels.  The sample should not be spinning during gradient shimming, 
the process may take a couple minutes to complete, and you may want to manually re-start the 
sample spinning on the Start tab's Spin/Temp page once the shimming is complete.

Shim Editor

In the Menu's Tools drop-down inside the “Standard Calibration Experiments” is the “Shim 
Editor...” option.  This option starts ProShim, which is a tool for algorithmically shimming using 
intensity fits to optimize shims.  ProShim is nowhere near “push the button and it works”, it 
takes some careful setup and know-how but can do a fine job.  ProShim is also versatile enough 
to do some fancy shimming routines, for example “shim on just the DSS peak”.

Hand Shimming

In the Start tab's Shim page there is a box of buttons with the shim labels on each button.  Here 
the user may manipulate each shim by right and left-clicking the associated button.  The general 
goal is to improve the lock or lineshape by changing the shims in a pattern that minimizes the 
amount of cross-shim interference.  There are many papers, books, and beliefs about how this is 
best done, pick one that works for you.

Keep in mind, shims that end in a “c” are coarse shims, and there is a corresponding shim 
without a “c” that is that fine shim.  For example, z1c and z1 are the same shim, but the first is a 
coarse adjustment and the second a fine adjustment.

Often hand shimming is not done alone.  More often than not the z-shims are set with gradient 
shimming, then a pattern for the non-spinning shims is followed until the z-shims are touched up 
again with gradient shimming.

Final Steps

If you have spent a good bit of time shimming, and you're happy with the results, you should 
save your work.  This may be done with a svs command, or by filling in the File field on the 
Start tab's Lock page and clicking the “Save shims” button.  



Tuning

The NMR probe is a LC circuit that is tunable to Larmor frequencies of the nuclei the probe is 
capable of detecting.  The idea behind tuning is to have a low impedance at the Larmor 
frequency to minimize the loss of pulse power being delivered to the sample and to minimize the
loss of signal lost returning to the console.  The probe is tuned/matched by manipulating variable
capacitors in the probe by turning wands that protrude from the base of the probe.  The exact 
requirements for how to do this tuning is somewhat instrument specific, but to start the software 
tuning go to the Menu's Tool's drop-down and select “Probe Tuning”, then “Manually Tune 
Probe”.

Direct Acquisition

This is the type of acquisition that seasoned VnmrJ users are used to.  There are several steps 
summarized here, which will be detailed more in training.  To acquire a spectrum using the direct
method use the following steps:

1. Put your sample in the magnet.

2. Click the base experiment you wish to run in the Experiment Selector.  The experiment 
should load and display the pulse sequence's rf profile.

3. In the Start tab's Sample Info page: choose the solvent.

4. In the Start tab click the Auto Lock button, and wait for it to complete.  If this should fail,
try locking by hand (see above).

5. In the Start tab click the Gradient Shim button.  (Skip this step and shim by hand if the 
probe cannot gradient shim – like the one on the Inova 300MHz).  The spinning should 
stop for gradient shimming, you should not be spinning when gradient shimming.

6. You can start the spinning up from the Start tab's Spin/Temp page by hand if you want to 
(choose 20Hz).  Once the spinning is stable you may polish the z-shims by hand if you 
like.  In general, this step is unnecessary, as the spinning will start automatically later and
the shims are often good enough following gradient shimming.

7. Next, in the Acquire tab customize the pulse sequence using the fields on the pages 
within the Acquire tab.  You'll find entries for every parameter used by your chosen 
experiment within these pages. Often a given parameter will appear in more than one 
location, as a convenience.

8. When everything is ready (including making sure the experiment ends at an appropriate 
time) then tap the Go button.  Sit back and wait for a block to complete, then either sit 
some more or process the data acquired to that point.

9. Once the system has become idle again, go to the File menu, mouse down to Save As and
save your data in your data directory.  Your data directory is within the vnmrsys directory 
and called data (~/vnmrsys/data).

10. Start a new sample, or replace the placeholder.  There's no need to lock the placeholder or
anything, just please put it back – don't leave the magnet empty.



Study Queue Acquisition

This is new to VnmrJ for most people.  It can be really handy for setting multiple things up, and 
letting the software do more work for you.  You still have to get the lock phase (roughly) correct, 
so do not fail to get your first lock on the system by hand.  The Study Queue lives in the bottom 
left corner of the software interface, to acquire data using the Study Queue do the following:

1. Put your sample in the magnet.

2. In the Study Queue area, click New Study.

3. In the Start tab's Sample Info page choose the solvent, provide a sample name, and 
choose any options there you fancy.  It is recommended that you provide some 
comments, at least.

4. Choose the experiment(s) from the Experiment Selector.  Notice that they are added to 
the Study Queue in order.  If you have added one in error, just drag-and-drop it to the 
trashcan in the bottom left.

5. Double-click each experiment and customize it within the Acquire tab's pages.

6. When all is ready, click submit.  The system should now lock, shim, and acquire all the 
experiments in the queue.  It will also automatically save the data in your data directory 
using he sample name, date, and a counter.

7. Start a new sample, or replace the placeholder.  There's no need to lock the placeholder or
anything, just please put it back – don't leave the magnet empty.

Normally, that's it.  Yes, you can stop a queue and do all sorts of fancier stuff, but that will be 
covered further in training.  One thing to mention here at least would be if you forgot to run an 
experiment on a sample, you can append that experiment by choosing to Continue a queue rather
than start a new one.  Oh, and the queue will show you the time require to complete each 
experiment and the queue as whole – no excuses for going over time.
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